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New Features

The following new features have been added in version 14.0 of Spotfire® Analyst.

For details about new Spotfire features, see What's New in Spotfire in the Community.

Key Version Summary

SPOT-3208 14.0.0 Spotfire is back!

Spotfire® is now a stand-alone brand within Cloud Software Group, and this is
reflected in a new logotype and new product names.

The following Spotfire products have been rebranded in this release:

● Spotfire Server

● Spotfire Analyst

● Spotfire Deployment Kit

● Spotfire Automation Services

● Spotfire Qualification

● Spotfire Developer

● Spotfire Enterprise Runtime for R (a/k/a TERR)

● Spotfire Enterprise Runtime for R – Server Edition (a/k/a the TERR Service)

● Spotfire Service for R

● Spotfire Service for Python

SPOT-3179 14.0.0 Run Spotfire Analyst without a server (combined installer with Spotfire Desktop)

You can now run Spotfire Analyst without connecting to a Spotfire Server, by selecting
the option 'No server' in the login dialog. If you decide to add a server at a later
stage, you can force the login dialog to be shown by searching for 'Spotfire' from the
Windows start menu, then selecting the 'Spotfire Analyst (show login dialog)' option,
 and clicking 'Manage servers' in the login dialog.

The installers for Spotfire Analyst and Spotfire Desktop have been combined. This
means that it is easier to switch from one of the sales offerings to another, if your
situation changes in the future.

SPOT-2150 14.0.0 Export tabular visualizations to Microsoft Excel with preserved layout, styling, and
formatting

You can now export the table, cross table, graphical table, and summary table
visualizations, to an Excel file, preserving their layout, styling, and formatting. This
makes it easier to share reports as tabular data, the way they were originally designed
in Spotfire.

Spotfire® Analyst Release Notes
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Key Version Summary

SPOT-2158 14.0.0 Enhanced configuration of the KPI chart 

Several new settings give you more control over the visual layout and formatting of
the KPI chart. You can now:

● Start each KPI on a new row to better distinguish them visually.

● Edit the base font style and size in the tiles.

● Set a dynamic tile width relative to the font size to ensure that the content of the
tiles is always displayed correctly. 

● Specify a minimum number of tiles per row to preserve the desired layout even
when the visualization is resized.

● Set a minimum number of visible tiles to ensure that a certain number of tiles
remain visible irrespective of the size of the visualization.

SPOT-2361 14.0.0 Configure version history per analysis from the Analyst client

An analyst can enable or disable the version history setting for each analysis in the
library from within the Spotfire Analyst client. By only saving the version history
for the most important analyses, you can keep the storage need for the library to a
minimum.

When an analysis is opened in the installed client, select File > Document Properties, go
to the Library tab and modify the Keep older versions of this file when saving check box to
change the setting. You need write permissions for the analysis to update the setting.

A system administrator can configure if the version history should be enabled or
disabled for all analyses by default. See Switching off library versioning in the
Spotfire® Server and Environment - Installation and Administration manual.

SPOT-3061 14.0.0 Manage column and data table property values from the data canvas

Since version 12.5, analysts and business authors have been able to add new column
and data table properties, and edit the default values, from the data tables overview in
the new data canvas sidebar.

With this release, analysis authors can also edit the actual column property and data
table property values directly from the data canvas, when selecting the final data table
node for a data table. This functionality is available both in the installed client and in
the web client.

Beyond making this capability available to web authors, the new functionality also
makes it more convenient to view and edit the metadata available for your columns
and data tables. For example, you can add or edit an optional description of the
content, change the content type, or update the link template used for columns that
should be interpreted as links.

SPOT-3067 14.0.0 'Reload for each user'-setting available in the data canvas

For an analysis configured to use scheduled updates, the data canvas now allows you
to enable or disable the reload of data per data source in each data table.

Scheduled updates save time for consumers by automating data loading for an
analysis before the analysis is opened. This reduces the need to wait for new data to
load when actually opening the analysis. However, not all data sources are suitable to
be preloaded, and now you can easily specify your exceptions from within the data
canvas. Read more in Reloading data for each user when using scheduled updates.

SPOT-3091 14.0.0 Catalog setting for data connections to Databricks

The data connector for Apache Spark SQL has a new setting for specifying what
catalog to access data from, when you create or edit a connection to a Databricks
system that is set up with unity catalog.
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Key Version Summary

SPOT-3092 14.0.0 Fetch size setting for data connections to Oracle

You can now configure the fetch size setting, when you create or edit an Oracle data
connection.

SPOT-3142 14.0.0 Access data from Google Analytics 4

You can now access data from Google Analytics 4 in Spotfire.

Google Analytics 4 is the current generation of Google Analytics. Google is retiring the
previous generation, Universal Analytics, which Spotfire already supports. In this, and
later versions of Spotfire, to access your legacy Universal Analytics data, select Connect
to > Google Analytics (Universal Analytics).

SPOT-3304 14.0.0 Contextual menus on filters in text areas

Some of the functionality from the right-click menus that are available in the Filters
panel and for filters in the Data in analysis flyout are now enabled also for filters in the
text area. This provides easy access to additional filter-specific capabilities in the text
area, such as the possibility to reset a filter, or to deselect other values in a hierarchy
filter.

TS-74327 14.0.0 Easy access to information about data sources in Information Designer

You can now right-click in the Data Sources pane of the Information Designer and select
Copy List of Data Sources to see information about all the data sources in your system.

This can be used to locate data sources that use TIBCO-branded DataDirect JDBC
drivers, which are no longer supported in Spotfire version 14.0 and forward.

Spotfire® Analyst Release Notes
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Changes in Functionality

The following are changes in functionality in version 14.0 of Spotfire® Analyst.

Key Version Summary

TS-69268 14.0.0 Data functions are no longer automatically removed when they lack outputs

Previously, when all outputs of a data function were removed, the data function was
also automatically removed from the analysis. This no longer happens because you
might want to reconfigure new outputs by editing the data function from the data
canvas at a later stage.

Spotfire® Analyst Release Notes
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Deprecated and Removed Features

Deprecated features

The table lists features that are deprecated and will be removed in a future release of Spotfire® Analyst.

Key Version Summary

TS-74041 14.0.0 The Column properties dialog in the Spotfire Analyst client is deprecated and it will be
removed in a future version.

With the option to edit data table and column property values from the data canvas,
 the old dialog (reached from Data > Column Properties) is no longer needed. You can
do everything except freezing columns from either the Data canvas or from the Data in
analysis flyout. The freeze columns functionality, when accessed via the dialog, is also
deprecated. API for frozen columns is still supported.

Deprecated since Spotfire 14.0.0.

Removed features

The following features have been removed in this version of Spotfire® Analyst.

Key Version Summary

SPOT-3232 14.0.0 Spotfire is no longer localized to Russian, and the Russian language pack is no longer
available.

Spotfire is localized to the following languages:

● Chinese

● French

● German

● Italian

● Japanese

● Korean

● Portuguese

● Spanish

Spotfire® Analyst Release Notes
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Third Party Software Updates

The following third party software (TPS) components have been added or updated in version 14.0 of
Spotfire® Analyst.

Key Version Summary

TS-78118 14.0.4 Bouncy Castle updated to 2.4.0

TS-77594 14.0.4 Chromium Embedded Framework updated to 127.3.4

TS-78117 14.0.4 HtmlAgilityPack updated to 1.11.63

TS-78104 14.0.4 Magick.NET-Q16-AnyCPU updated to 13.10.0

TS-78100 14.0.4 Spotfire Enterprise Runtime for R (a/k/a TERR) engine updated to 6.1.4

TSDC-7491 14.0.4 TIBCO Data Virtualization ADO.NET Driver updated to 8.8.2

TS-78107 14.0.4 preact/signals updated to 1.3.0

TS-78130 14.0.4 underscore js updated to 1.13.7

TSDC-7507 14.0.4
● Azure.Identity updated to 1.12.0

● Microsoft.Identity.Client updated to 4.61.3

TS-77132 14.0.3 Apache Log4Net updated to 2.0.17

TS-76164 14.0.3 Bouncy Castle updated to 2.3.0

TS-77143 14.0.3 Chromium Embedded Framework updated to 124.3.0

TS-77134 14.0.3 HtmlAgilityPack updated to 1.11.60

TS-76635 14.0.3 Magick.NET-Q16-AnyCPU updated to 13.6.0

TS-77124 14.0.3 Spotfire Enterprise Runtime for R (a/k/a TERR) engine updated to 6.1.3

TS-76638 14.0.3 Topten.RichTextKit updated to 0.4.167

TS-77136 14.0.3 mono/SkiaSharp updated to 2.88.8

TS-77137 14.0.3 preact updated to 10.20.2

TS-77138 14.0.3 preact/signals updated to 1.2.3

Spotfire® Analyst Release Notes
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Key Version Summary

TS-76897 14.0.3
● Python interpreter updated to 3.11.9

● The following Python packages are updated in this release:

— pandas updated to 2.2.2

— setuptools updated to 69.5.1

TS-75953 14.0.2 HtmlAgilityPack updated to 1.11.57

TS-75941 14.0.2 Magick.NET-Q16-AnyCPU updated to 13.5.0

TS-76139 14.0.2 Spotfire Enterprise Runtime for R updated to version 6.1.2

TSDC-7328 14.0.2 TIBCO Data Virtualization ADO.NET Driver updated to version 8.8.0

TS-75942 14.0.2 mono/SkiaSharp updated to 2.88.7

TS-75972 14.0.2 preact updated to 10.19.3

TSDC-7336 14.0.2
● Microsoft.Data.SqlClient updated to 5.1.4

● Microsoft.IdentityModel.Abstractions updated to 6.35.0

● Microsoft.IdentityModel.JsonWebTokens updated to 6.35.0

● Microsoft.IdentityModel.Logging updated to 6.35.0

● Microsoft.IdentityModel.Protocols updated to 6.35.0

● Microsoft.IdentityModel.Protocols.OpenIdConnect updated to 6.35.0

● Microsoft.IdentityModel.Tokens updated to 6.35.0

TSDC-7306 14.0.1 Azure.Identity updated to 1.10.3

TS-75041 14.0.1 HtmlAgilityPack updated to 1.11.54

TS-75107 14.0.1 Magick.NET-Q16-AnyCPU updated to 13.4.0

TS-75045 14.0.1 System.Security.Cryptography.pkcs updated to 6.0.4

TS-75085 14.0.1 System.ServiceModel.Http updated to 4.10.3

TS-75086 14.0.1 System.ServiceModel.Primitives updated to 4.10.3

TS-75340 14.0.1 The Package for Building Python Extensions to Spotfire® is updated to 2.1.2.

The following bundled Python packages are updated:

● NumPy updated to 1.26.2

● Pandas updated to 2.1.3

● pip updated to 23.3.1

● setuptools updated to 68.2.2

● wheel updated to 0.41.3

Spotfire® Analyst Release Notes
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Key Version Summary

TS-75042 14.0.1 jQuery updated to 3.7.1

TS-75084 14.0.1 preact updated to 10.18.2

TS-75044 14.0.1 system.private.servicemodel updated to 4.10.3

TS-74406 14.0.1
● HarfBuzzSharp updated to 7.3.0

● mono/SkiaSharp updated to 2.88.6

TS-74724 14.0.0 Chromium Embedded Framework updated to 117.2.4

TS-73784 14.0.0 DocumentFormat.OpenXml updated to 2.20.0

TS-73779 14.0.0 HtmlAgilityPack updated to 1.11.51

TS-73780 14.0.0 Magick.NET-Q16-AnyCPU updated to 13.2.0

TS-74003 14.0.0 Spotfire Enterprise Runtime for R (a/k/a TERR) engine updated to 6.1.0

TS-73789 14.0.0 jQuery updated to 3.7.0

TSDC-7146 14.0.0
● Apache.Arrow updated to 12.0.1

● Google.Api.CommonProtos updated to 2.10.0

● Google.Api.Gax updated to 4.4.0

● Google.Api.Gax.Grpc updated to 4.4.0

● Google.Apis.Analytics.v3 updated to 1.61.0.1679

● Google.Apis.Auth updated to 1.61.0

● Google.Apis.Oauth2.v2 updated to 1.61.0.1869

● Google.Cloud.BigQuery.Storage.V1 updated to 3.8.0

● Google.Cloud.BigQuery.V2 updated to 3.4.0

● Google.Protobuf updated to 3.23.3.0

● Grpc.Core updated to 2.46.6

TSDC-7282 14.0.0
● Google.Analytics.Admin.V1Beta version 1.0.0-beta03 added

● Google.Analytics.Data.V1Beta version 2.0.0-beta03 added

TSDC-7199 14.0.0
● Microsoft.Data.SqlClient updated to 5.1.1

● NodaTime updated to 3.1.9

● System.Diagnostics.DiagnosticSource updated to 6.0.1

● System.IdentityModel.Tokens.Jwt updated to 6.31.0

● System.Text.Encodings.Web updated to 6.0.0

Spotfire® Analyst Release Notes
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Key Version Summary

TS-73009 14.0.0
● Python interpreter updated to version 3.11.3

● The following Python packages are updated in this release:

— NumPy updated to 1.25.2

— pandas updated to 2.1.0

— pip updated to 23.2.1

— setuptools updated to 68.1.2

— spotfire (Package for Building Python Extensions to Spotfire) updated to 2.1.1

— wheel updated to 0.41.2

Spotfire® Analyst Release Notes
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Closed Issues

The table lists closed issues in version 14.0 of Spotfire® Analyst.

Key Version Summary

TS-77254 14.0.4 When using the mods API to mark a large number of rows (>100), some of the rows
are sometimes omitted.

TS-77352 14.0.4 The AutoBinNumeric function can generate too few bins when the column formatting
does not include enough decimal digits.

TS-77434 14.0.4 Marking sometimes does not work as expected if filtering is performed while (Row
number) is used on a splitting axis.

TS-77646 14.0.4 Export data to file does not work for the Details-on-Demand panel if Spotfire runs in
another language than English.

TS-77649 14.0.4 If an item filter is used without Include (None) as option selected, there are missing items
in the filter result.

TS-77679 14.0.4 Spotfire is sometimes not responsive when you try to highlight or mark vertical (north-
south) well sticks in a map chart.

TS-77704 14.0.4 When the RefreshOnDemandData callback is invoked from an IronPython script,
 and the callback parameter is a function that generates an exception, Spotfire closes
unexpectedly.

TS-77791 14.0.4 If properties are not previously registered but show up when loading data, they are
created with a valid value for the data type, for example, the number '0' for integers.
 However, the expected default value should be null, to be able to separate absence of a
value from a valid value.

The preference UseNullAsDefaultValueForNewProperties (under
DataImportSettings) has been added to support this scenario. By default, the old
behavior is kept.

TS-77794 14.0.4 Depending on the load/creation order of the data tables, it is sometimes impossible to
open an analysis file when you have done K-means clustering on a data table which is
defined with relations and also filter propagation from it but not to it.

TS-77838 14.0.4 It is not possible to perform a K-means clustering or a Line similarity calculation based
on a line chart that uses a hierarchy on an axis.

TS-77914 14.0.4 The hex color code cannot be edited when the color palette is opened from the styling
options popover in the table visualization.

TS-78021 14.0.4 Some performance counters are missing in the Monitoring & Diagnostics page of the
Spotfire Server web administration pages: "Data engine paged out memory", "Data
engine paged in memory", "Data engine active queries" and possibly "Number of
shared document nodes".

TS-78052 14.0.4 Some analyses with filter propagation and K-means clustering, and/or line similarity
calculations, cannot be opened.

Spotfire® Analyst Release Notes
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Key Version Summary

TS-78169 14.0.4 Clicking the Minimize button of an annotation opens the annotation in input mode
instead of minimizing it.

TS-78354 14.0.4 In the Register Data Function dialog, the Save as, Export, and Run buttons are sometimes
not enabled after changing the Type.

TSDC-7514 14.0.4 If you add line breaks in the description of a prompt in a data connection, the
description does not display correctly in the prompt dialog.

TSDC-7517 14.0.4 When you access large amounts of data with the connector for MySQL, and you use a
version of the ODBC driver later than 8.0, Spotfire sometimes stops unexpectedly.

TSDK-718 14.0.4 The Spotfire Package Builder cannot be opened and can sometimes cause the
application to close unexpectedly, when running a German version of Spotfire Analyst.

TS-76056 14.0.3 When the API has been used to define relations between data tables (DataRelations),
and the relations use more functionality than what is available in the user interface, the
Data Table Properties dialog cannot be opened.

This issue can also happen if an analysis is created or modified using Spotfire 14.2 or
newer, and is then opened using an older version. The new versions support more
complex data relations in the user interface.

TS-76073 14.0.3 If you click instead of drawing a rectangle when attempting to zoom in a visualization,
 Spotfire closes unexpectedly.

TS-76110 14.0.3 If new versions of related packages are deployed to a Spotfire Server and one or more
of these packages are removed from the set, Spotfire Analyst can close unexpectedly,
 or show an exception in runtime, if a user declines to update to the new version of the
set of packages.

TS-76172 14.0.3 You cannot open an analysis containing a data connection with saved credentials, if
you change the authentication method in the data source to a method that does not
support saved credentials.

TS-76181 14.0.3 When setting indexed properties from IronPython using a CategoryKey, Spotfire
closes unexpectedly with a StackOverflowException.

TS-76285 14.0.3 It is not possible to load on-demand data from an information link if the ID of a
column used to filter by has been changed, but the original name of the column still
remains.

TS-76336 14.0.3 It is not possible to configure a reference line to be based on a column property for a
binned axis.

TS-76385 14.0.3 When running the Application Profiler on a folder containing multiple analysis files
based on information links, the application sometimes starts in offline mode.

TS-76444 14.0.3 The Data Table Properties dialog sometimes shows the wrong value for the "Prompt for
new settings before loading" setting.

TS-76447 14.0.3 Spotfire becomes unresponsive and then closes when an extension performs a progress
operation in which another progress operation is asynchronously launched.

Spotfire® Analyst Release Notes
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Key Version Summary

TS-76595 14.0.3 The login dialog does not display the product name configured via the cobranding
package.

TS-76677 14.0.3 Shapefiles containing gaps between the shapes cannot be opened.

TS-76743 14.0.3 Localized exception messages shown at initial startup (at assembly loading) that
require UTF-8 encoding to be properly rendered (for example, for a web player service
instance) can be garbled.

TS-76787 14.0.3 If an HTTP error occurs when retrying exporting SBDF data to the library using File/
Export/Data to library, the Automation Services task Export Data Table to
Library, or the API DataTable.ExportDataToLibrary, it can result in only part of
the data table being saved to the library.

TS-76807 14.0.3 Run action with preview does not work when the action trigger is a title bar button.

TS-76976 14.0.3 When setting the TypeId of a visualization and adding a reference line using an
IronPython script, an exception is thrown in the script.

TS-76995 14.0.3 When certain fonts are used, texts might not be displayed in all the expected places in
Spotfire.

TS-77113 14.0.3 When trying to replace an unsigned .mod file in an analysis with a signed version of
that file, the unsigned .mod file is not updated with the signed file.

TS-77187 14.0.3 Sometimes, tooltips do not disappear as expected in a visualization mod.

TS-77220 14.0.3 Spotfire sometimes closes unexpectedly when you edit the value of a document
property that uses an invalid IronPython script.

TSDC-7407 14.0.3 When you use Spotfire with the Brazilian Portuguese language pack, an error occurs
when you search the library and multiple data connectors in the results share the same
display name.

TS-75596 14.0.2 Switching between pages in an analysis while data is being fetched can sometimes
cause visualization mods to leak memory.

TS-75624 14.0.2 When using on-demand data tables, internal structures can sometimes be rebuilt
unnecessarily, which leads to information link metadata being fetched more often than
needed.

TS-75739 14.0.2 When you use Information Designer, Spotfire sometimes stops unexpectedly due to
errors on the Spotfire Server. 

TS-75819 14.0.2 Renaming a data table column, then loading empty data, and finally loading the actual
data again can sometimes make the renaming disappear.

TS-75932 14.0.2 Attempting to copy a visualization or page sometimes causes Spotfire to close
unexpectedly.

TS-74534 14.0.1 Tooltips for values on axis scales and in trellis headers are cut off after 100 characters in
non-tabular visualizations. The limit has now been increased to 300 characters.

Spotfire® Analyst Release Notes
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Key Version Summary

TS-74563 14.0.1 Using the function NavigatePeriod in an expression with an incomplete Axis expression,
 or using PruneHierarchy with incomplete Hierarchy names, causes the application to
close unexpectedly.

TS-74576 14.0.1 In trellised map charts, there are no tooltips for the trellis headers.

TS-74579 14.0.1 The cobranding splash screen logo is sometimes cut off during an upgrade of Spotfire.

TS-74591 14.0.1 Using a fixed height on a list box filter in the text area can sometimes lead to too much
whitespace in the list box filter.

TS-74690 14.0.1 The Select deployment area drop-down list in the login dialog is unresponsive when
running on Microsoft Windows Server 2016 and 2019.

TS-74737 14.0.1 The registration of a custom third-party component with an icon prevents the
application from starting.

TS-74938 14.0.1 The Administration Manager User Guide is missing the table of contents.

TS-75036 14.0.1 The text area creates and calls rendering code for controls that are not visible, which
might cause Spotfire to become unresponsive in certain situations.

TS-75140 14.0.1 When having multiple hierarchy levels in trellis headers, some levels are not shown if
a previous level has a very long label.

TS-75195 14.0.1 Clicking an item from the Lists panel does not select it.

TS-75207 14.0.1 When using a data connection with more than one view, and one of the views is
configured to be loaded on-demand, excluding the output from the on-demand view
when adding data prevents the operation from succeeding.

TS-75226 14.0.1 The first time you open RStudio from TERR Tools in the Spotfire Analyst, you might
see an error saying that the file Desktop.ini is not found.

TS-75268 14.0.1 When sorting KPI charts using Best first and Worst first, KPIs with empty (null) values
are not sorted as expected.

TS-75292 14.0.1 Single point geometries without borders are not shown in table visualizations.

TS-75306 14.0.1 If labels in feature layers in the map chart contain newline characters, the labels are
rendered as a single line with ellipsis instead of showing the entire label.

TS-75448 14.0.1 When adding or replacing data from the Data canvas, it is not possible to paste or drag
and drop data files into the application.

TS-75451 14.0.1 When using an on-demand data table and caching is enabled, occasionally no data is  
returned.

TSDC-7292 14.0.1 When you edit an Oracle data connection, in some cases, the Connection type radio
buttons are empty and do not indicate the selected option.

Spotfire® Analyst Release Notes
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Key Version Summary

TSDC-7305 14.0.1 When you access data with the connector for BigQuery, you cannot use Storage API
unless you use a service account.

TSDC-7312 14.0.1 When you access data with the connector for OData, you cannot access decimal type
data with the Scale set to variable or floating.

TS-61559 14.0.0 When using an information link on demand, the data canvas does not show the
updated path and name in the source information after the information link has been
renamed, copied, or moved.

TS-61921 14.0.0 When adding many columns to a table visualization at the same time, Spotfire might
temporarily become unresponsive.

TS-63958 14.0.0 It is possible to add data functions to an analysis from the content browser even if the '
Execute Data Functions' license has been switched off.

TS-68584 14.0.0 When using the Find tool, the search for some columns is never finished.

TS-68968 14.0.0 Temporary files created by Spotfire applications sometimes have double extensions.

TS-71234 14.0.0 When waking up the computer from sleep mode, the Spotfire user interface sometimes
becomes blank.

TS-72246 14.0.0 When having many information links in a Spotfire analysis file, and both Information
Services and the database are very busy, on rare occasions, parallell data loading never
gets finished.

TS-72470 14.0.0 Names from a previous analysis reappear when renaming markings in the Markings
panel.

TS-72571 14.0.0 Search does not work as expected in drop-down lists when the search does not match
any items.

TS-72657 14.0.0 In the Export data to file dialog, if you select a file format first, and then switch
between Visualization and Data table, or switch between different visualizations in the
Visualization drop-down list, the selected file format is lost.

TS-72684 14.0.0 In the text area, links with a target attribute do not open a tab in the default web
browser.

TS-72722 14.0.0 In the Markings panel, custom visualizations are not included in the number of
visualizations using a marking.

TS-72782 14.0.0 The active text area is not shown as highlighted in the Markings panel.

TS-72798 14.0.0 When replacing a data table, the Favorites view in the Files and data flyout shows items
that cannot be used to replace a data table.

TS-72803 14.0.0 In the Favorites section of the Files and data flyout, for visualization mods, there is an
option to click Open in the context menu as well as in the details view. However, this
option does not do anything when no data (no analysis) is loaded.
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Key Version Summary

TS-72819 14.0.0 In the Spotfire® Cobranding user guide, the topic Creating and deploying a
cobranding package is missing information about where to find the Modules directory.

TS-72828 14.0.0 Multiple scrollbars are shown simultaneously when a long text is added in the Replace
value with popover.

TS-72938 14.0.0 The PYPI package repository deprecated and removed the search function.
 As a result, the instruction for searching the package repository in the topic "
Troubleshooting Downloading Python Packages from a Proxy or Firewall Protected
Installation" in the Python Data Functions in Spotfire results in an error.  

TS-72947 14.0.0 The Spotfire client is not responding when adding many columns to a table
visualization.

TS-73080 14.0.0 Resize columns to fit does not work correctly for tables and cross tables with vertical
headers.

TS-73132 14.0.0 Marking rows in a Spotfire visualization mod is slow when marking more than 100,
000 rows.

TS-73174 14.0.0 Images in cross tables can be rendered in the wrong cell.

TS-73609 14.0.0 The map chart marker layer has the wrong icon in the right-click menu of the Markings
panel.

TS-73623 14.0.0 The custom projection definition (proj4definition) and the display name are not
always serialized, which causes them to not exist when the file is deserialized.

TS-73626 14.0.0 Switching between pages in an analysis causes a memory leak.

TS-73628 14.0.0 Selecting or adding a large number of predictor columns in the predictive modeling
dialog can be slow.

TS-73643 14.0.0 Spotfire becomes unresponsive if you attempt to add a calculated value based on
Column from marked in a text area.

TS-73778 14.0.0 When running Spotfire with the Korean language pack, the application sometimes
closes unexpectedly if you filter to or out marked rows.

TS-73793 14.0.0 In rare cases, changed settings are not applied when clicking OK in the Add columns or
Add rows dialogs.

TS-73814 14.0.0 When adding a drop-down list property control to a text area, it is too easy to
accidentally use the Spotfire column property 'ValidInsightPredictor' to store the
selectable columns in.

TS-73838 14.0.0 In the dark visual theme, the styling is incorrect on changed filters that are opened
from the bottom of the Filters panel.

TS-73862 14.0.0 There is no input validation for the KPI chart preference PreferredTileWidth in the
Administration Manager. When an invalid number has been entered and the Tools >
Options settings for the KPI chart are reset, Spotfire closes unexpectedly.
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Key Version Summary

TS-73947 14.0.0 Data is intermittently not formatted correctly if specific regional settings, such as
which decimal separator to use, have been changed from the default regional setting.

TS-74055 14.0.0 The status bar shows incorrect information about rows for the current visualization.

TS-74071 14.0.0 When exporting data of the data type SingleReal to text or csv files, only the visible
number of digits (as specified by the column formatter) are exported, instead of the
maximum precision.

TS-74593 14.0.0 Sometimes it is not possible to open the Markings panel as expected.

TSDC-7194 14.0.0 When you access data with the connector for Google BigQuery, it is not possible to
access repeated columns that contain elements with null values.

TSDC-7223 14.0.0 With the following data connectors, you cannot use the authentication method
Username:

● Apache Spark SQL

● Cloudera Hive

● Hortonworks

TSDC-7224 14.0.0 When you access data with the connector for Snowflake, it is not possible to add and
validate custom queries until all the tables in the database have been loaded.

TSDC-7227 14.0.0 When you click the Help button in the Load data from Google Analytics dialog, the
user guide does not appear.

TSDC-7244 14.0.0 When you edit a MySQL or an Oracle connection, sometimes the wrong data source
settings are applied. 

TSDC-7270 14.0.0 When you access data with the connector for TIBCO Data Virtualization, and you use
the load method on-demand, it is not possible to use a range input for the on-demand
parameter.

TSDC-7281 14.0.0 When you access Date and Datetime data with the connector for Salesforce, Spotfire
does not account for the user's settings in Salesforce for the format of such data (for
example YYYY-MM-DD or MM-DD-YYYY), which can result in errors.
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Known Issues

The following are known issues in version 14.0 of Spotfire® Analyst.

Key Version Summary

TS-62137 14.0.0 Package installation precedence rules

Python packages that are installed by the Administrator (through an SPK) take
precedence over packages installed using the Python Tools from the Spotfire Analyst
Tools menu. If users attempt to update a package previously installed by an SPK, then
the package update is installed, but the update is ignored.

TS-67478 14.0.0 Data connections created with Amazon Redshift in Spotfire 11.5.0 incompatible
with earlier versions

Data connections created in Spotfire versions 11.5.0 and later using the TIBCO Spotfire
Connector for Amazon Redshift cannot be opened in versions earlier than 11.5.0.

Workaround: Refresh the schema and perform a table repair for the Data Connection
view.

TS-67656 14.0.0 "Unable to write data" error message

Error message "Unable to write data to the transport connection: An
established connection was aborted by the software in your host

machine."

If you see this error, then the data being uploaded to the service is too large. When
a Spotfire data function is run, it sends the relevant data from Spotfire to the service
for processing. The service has a file size upload limit, the default of which is 100 MB.
 When a data function is run with data that exceeds this limit, the service returns the
error.

An administrator can change this upload limit if needed by creating a custom
configuration. For more information, see the topic "File size upload limit" in the service
Installation and Administration guide.

If users see this error message, the administrator can consider creating a custom
configuration that increases the limits for both of the following properties:

● spring.servlet.multipart.max-file-size: The total file size for upload
cannot exceed the value for this setting.

● spring.servlet.multipart.max-request-size: The total request size for a
multipart file upload cannot exceed the value for this setting.

 

Note:  At a certain point, the Java Heap size fails to handle very large files. The
threshold for this behavior is dependent on the amount of RAM the service node has.
 When the Java Heap Size is exceeded, the following error message is displayed.

Error from Remote Service: Internal Server Error (500) - java.lang.

OutOfMemoryError: Java heap space
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Key Version Summary

TS-69770 14.0.0 Empty String columns in exported SBDF causes an error

If you export an SBDF from Python (for example, as outputs for a data function), and
your output contains an empty column, then you can encounter the following error:

spotfire.sbdf.SBDFError: cannot determine type for column 'EmptyString'

; all values are missing

This error occurs because the Spotfire data function environment cannot determine
the proper Spotfire type to export the data as if all values in the column are missing (in
other words, Python's None, NumPy's nan, or Panda's NA or NaT values).  

Workaround:

To resolve this issue, edit your data function to use the helper function set_spotfire_
types.

Example

import pandas as pd
import spotfire
df = pd.DataFrame(inp)
spotfire.set_spotfire_types(df, {'EmptyString': 'String'})
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Installation

The following are instructions on how to install version 14.0 of Spotfire® Analyst.

The Spotfire Analyst client is delivered as two different installers. The installer labelled "single_user" is
the default one. Use this if you do not know which version to select. The installer labelled "single_user"
installs the product for the logged in user only. The other users on the same machine will not be able to
use the client. The installer labelled "shared_computer" installs the product for all users on the machine.
This installer requires administrative privileges on the machine.

There are separate instructions available for installing Spotfire Analyst without a server on the
documentation site.

Installation of Release 14.0

1. First install/upgrade the Spotfire® Server to version 14.0.

2. Deploy the Spotfire 14.0 distribution on the Spotfire Server 14.0.

3. Finally, install Spotfire Analyst 14.0 on all client computers.

Installation Notes

● If the .NET 4.8 framework is not installed, it will be downloaded and installed when launching the
"shared_computer" Spotfire Analyst client installer. The "single_user" installer will not download
the .NET framework, because it does not have system changing privileges. However, it will
complain if the .NET framework is missing.

● If the product localization is defined as a user group preference, a client restart is required after
the initial login to the server for the changes to be fully applied. Note that clients are not informed
that such a restart is required. It is also important that the appropriate localization packages are
deployed to the Spotfire Server prior to setting the user group preference.

Note that the correct language pack and the matching server preference must be set on the very first
server that the user connects to. Changing the settings on the Server will not have any effect. If the
localization group preference does not have any effect, it can be enforced on clients using Tools >
Options.
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Migration and Compatibility

The following are instructions on how to migrate from a previous release to version 14.0 of Spotfire®

Analyst.

Upgrading from Previous Version without Installing

1. First install/upgrade the Spotfire® Server to version 14.0.

2. Deploy the Spotfire 14.0 distribution on the Spotfire Server 14.0.

3. Start the old version of Spotfire Analyst, log on to the Spotfire Server 14.0 and accept the update.

Compatibility Versions

You can use Spotfire 14.0 to open .dxp analysis files that were created and saved in any older version of
Spotfire that is still in support.

The compatibility versions of Spotfire 14.0 are updated to versions 14.0 and 12.0 LTS. This means
that .dxp analysis files that you create and save in Spotfire 14.0 can be opened in versions 14.0 and 12.0
LTS of Spotfire.

When you use an older version of Spotfire to open an analysis file that was created in a newer
version of Spotfire, features from the newer version might not be available, and the analysis
might look and behave differently compared to the version in which it was created.

Version Compatibility versions

14.0 LTS 12.5, 12.0 LTS

12.5 12.4, 12.0 LTS

12.4 12.3, 12.0 LTS

12.3 12.2, 12.0 LTS

12.2 12.1, 12.0 LTS

12.1 12.0 LTS, 11.4 LTS

12.0 LTS 11.8, 11.4 LTS

11.8 11.7, 11.4 LTS

11.7 11.6, 11.4 LTS

11.6 11.5, 11.4 LTS

11.5 11.4 LTS, 10.10 LTS

11.4 LTS 11.3, 10.10 LTS

10.10 LTS 10.9, 10.3 LTS

Spotfire® Analyst Release Notes



23

File compatibility example

For example, when you create a .dxp analysis file in Spotfire 12.3, the file is saved with
compatibility versions for 12.2 and 12.0 LTS. You can open the .dxp file in any older Spotfire
version that either is one of those versions, or has 12.2 or 12.0 LTS as compatibility versions.

That means you can open the .dxp analysis file that you saved in Spotfire 12.3 in the following
older versions: 12.2, 12.1, and 12.0 LTS.

Newer and older versions of Spotfire Analyst client can be used to connect to the current version of
Spotfire Server in order to upgrade or downgrade the client packages. However, it is recommended
to always run the same version of client and server in production environments. See System
Requirements.
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Spotfire Documentation and Support Services

For information about the Spotfire® products, you can read the documentation, contact Spotfire
Support, and join the Spotfire Community.

How to Access Spotfire Documentation

Documentation for Spotfire and TIBCO products is available on the TIBCO Product Documentation
website, mainly in HTML and PDF formats.

The website is updated frequently and is more current than any other documentation included with the
product.

Spotfire Documentation

The documentation for all Spotfire products is available on the Spotfire Documentation page. This page
takes you directly to the latest version of each document.

To see documents for a specific Spotfire product or version, click the link of the product under 'Other
versions', and on the product page, choose your version from the top right selector.

Release Version Support

Some release versions of Spotfire products are designated as long-term support (LTS) versions. LTS
versions are typically supported for up to 36 months from release. Defect corrections will typically be
delivered in a new release version and as hotfixes or service packs to one or more LTS versions. See also
https://spotfi.re/lts.

How to Contact Support for Spotfire Products

You can contact the Support team in the following ways:

● For accessing the Support Knowledge Base and getting personalized content about products you are
interested in, visit the support portal at https://spotfi.re/support.

● For creating a Support case, you must have a valid maintenance or support contract with Cloud
Software Group, Inc. You also need a user name and password to log in to https://spotfi.re/support.
If you do not have a user name, you can request one by clicking Register on the website.

System Requirements for Spotfire Products

For information about the system requirements for Spotfire products, visit https://spotfi.re/sr.

How to join the Spotfire Community

The Spotfire Community is the official channel for Spotfire customers, partners, and employee
subject matter experts to share and access their collective experience. The Community offers access to
Q&A forums, product wikis, and best practices. It also offers access to extensions, adapters, solution
accelerators, and tools that extend and enable customers to gain full value from Spotfire products.
In addition, users can submit and vote on feature requests from within the Ideas Portal. For a free
registration, go to https://spotfi.re/community.
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Legal and Third-Party Notices

SOME CLOUD SOFTWARE GROUP, INC. ("CLOUD SG") SOFTWARE AND CLOUD SERVICES
EMBED, BUNDLE, OR OTHERWISE INCLUDE OTHER SOFTWARE, INCLUDING OTHER
CLOUD SG SOFTWARE (COLLECTIVELY, "INCLUDED SOFTWARE"). USE OF INCLUDED
SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR PROVIDE LIMITED ADD-ON
FUNCTIONALITY) OF THE LICENSED CLOUD SG SOFTWARE AND/OR CLOUD SERVICES. THE
INCLUDED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY OTHER CLOUD
SG SOFTWARE AND/OR CLOUD SERVICES OR FOR ANY OTHER PURPOSE.

USE OF CLOUD SG SOFTWARE AND CLOUD SERVICES IS SUBJECT TO THE TERMS
AND CONDITIONS OF AN AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED
AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER
AGREEMENT WHICH IS DISPLAYED WHEN ACCESSING, DOWNLOADING, OR INSTALLING
THE SOFTWARE OR CLOUD SERVICES (AND WHICH IS DUPLICATED IN THE LICENSE FILE) OR
IF THERE IS NO SUCH LICENSE AGREEMENT OR CLICKWRAP END USER AGREEMENT, THE
LICENSE(S) LOCATED IN THE "LICENSE" FILE(S) OF THE SOFTWARE. USE OF THIS DOCUMENT
IS SUBJECT TO THOSE SAME TERMS AND CONDITIONS, AND YOUR USE HEREOF SHALL
CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this document
may be reproduced in any form without the written authorization of Cloud Software Group, Inc.

Spotfire, the Spotfire logo, TERR, and TIBCO are either registered trademarks or trademarks of Cloud
Software Group, Inc. in the United States and/or other countries. A list of Cloud SG's trademarks and
trademark guidelines is available at https://www.cloud.com/legal.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only. You acknowledge that all rights
to these third party marks are the exclusive property of their respective owners. Please refer to Cloud
SG's Third Party Trademark Notices (https://www.cloud.com/legal) for more information.

This document includes fonts that are licensed under the Apache License, Version 2.0, which is
available at https://www.apache.org/licenses/LICENSE-2.0 and reprinted in the Addendum below.

Copyright (c) Christian Robertson / Google, Roboto font.

Cloud SG software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. See the "readme" file for the
availability of a specific version of Cloud SG software on a specific operating system platform.

THIS DOCUMENT IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL
ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE
CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. CLOUD SG MAY
MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S), THE PROGRAM(S), AND/OR
THE SERVICES DESCRIBED IN THIS DOCUMENT AT ANY TIME WITHOUT NOTICE.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY
OR INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE,
INCLUDING BUT NOT LIMITED TO ANY RELEASE NOTES AND "README" FILES.

This and other products of Cloud SG may be covered by registered patents. For details, please refer to
the Virtual Patent Marking document located at https://www.tibco.com/patents.

Copyright © 1994-2024 Cloud Software Group, Inc. All Rights Reserved.
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Addendum to Legal and Third-Party Notices

                                 Apache License
                           Version 2.0, January 2004
                        http://www.apache.org/licenses/

   TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

   1. Definitions.

      "License" shall mean the terms and conditions for use, reproduction,
      and distribution as defined by Sections 1 through 9 of this document.

      "Licensor" shall mean the copyright owner or entity authorized by
      the copyright owner that is granting the License.

      "Legal Entity" shall mean the union of the acting entity and all
      other entities that control, are controlled by, or are under common
      control with that entity. For the purposes of this definition,
      "control" means (i) the power, direct or indirect, to cause the
      direction or management of such entity, whether by contract or
      otherwise, or (ii) ownership of fifty percent (50%) or more of the
      outstanding shares, or (iii) beneficial ownership of such entity.

      "You" (or "Your") shall mean an individual or Legal Entity
      exercising permissions granted by this License.

      "Source" form shall mean the preferred form for making modifications,
      including but not limited to software source code, documentation
      source, and configuration files.

      "Object" form shall mean any form resulting from mechanical
      transformation or translation of a Source form, including but
      not limited to compiled object code, generated documentation,
      and conversions to other media types.

      "Work" shall mean the work of authorship, whether in Source or
      Object form, made available under the License, as indicated by a
      copyright notice that is included in or attached to the work
      (an example is provided in the Appendix below).

      "Derivative Works" shall mean any work, whether in Source or Object
      form, that is based on (or derived from) the Work and for which the
      editorial revisions, annotations, elaborations, or other modifications
      represent, as a whole, an original work of authorship. For the
 purposes
      of this License, Derivative Works shall not include works that remain
      separable from, or merely link (or bind by name) to the interfaces of,
      the Work and Derivative Works thereof.

      "Contribution" shall mean any work of authorship, including
      the original version of the Work and any modifications or additions
      to that Work or Derivative Works thereof, that is intentionally
      submitted to Licensor for inclusion in the Work by the copyright owner
      or by an individual or Legal Entity authorized to submit on behalf of
      the copyright owner. For the purposes of this definition, "submitted"
      means any form of electronic, verbal, or written communication sent
      to the Licensor or its representatives, including but not limited to
      communication on electronic mailing lists, source code control
 systems,
      and issue tracking systems that are managed by, or on behalf of, the
      Licensor for the purpose of discussing and improving the Work, but
      excluding communication that is conspicuously marked or otherwise
      designated in writing by the copyright owner as "Not a Contribution."
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      "Contributor" shall mean Licensor and any individual or Legal Entity
      on behalf of whom a Contribution has been received by Licensor and
      subsequently incorporated within the Work.

   2. Grant of Copyright License. Subject to the terms and conditions of
      this License, each Contributor hereby grants to You a perpetual,
      worldwide, non-exclusive, no-charge, royalty-free, irrevocable
      copyright license to reproduce, prepare Derivative Works of,
      publicly display, publicly perform, sublicense, and distribute the
      Work and such Derivative Works in Source or Object form.

   3. Grant of Patent License. Subject to the terms and conditions of
      this License, each Contributor hereby grants to You a perpetual,
      worldwide, non-exclusive, no-charge, royalty-free, irrevocable
      (except as stated in this section) patent license to make, have made,
      use, offer to sell, sell, import, and otherwise transfer the Work,
      where such license applies only to those patent claims licensable
      by such Contributor that are necessarily infringed by their
      Contribution(s) alone or by combination of their Contribution(s)
      with the Work to which such Contribution(s) was submitted. If You
      institute patent litigation against any entity (including a
      cross-claim or counterclaim in a lawsuit) alleging that the Work
      or a Contribution incorporated within the Work constitutes direct
      or contributory patent infringement, then any patent licenses
      granted to You under this License for that Work shall terminate
      as of the date such litigation is filed.

   4. Redistribution. You may reproduce and distribute copies of the
      Work or Derivative Works thereof in any medium, with or without
      modifications, and in Source or Object form, provided that You
      meet the following conditions:

      (a) You must give any other recipients of the Work or
          Derivative Works a copy of this License; and

      (b) You must cause any modified files to carry prominent notices
          stating that You changed the files; and

      (c) You must retain, in the Source form of any Derivative Works
          that You distribute, all copyright, patent, trademark, and
          attribution notices from the Source form of the Work,
          excluding those notices that do not pertain to any part of
          the Derivative Works; and

      (d) If the Work includes a "NOTICE" text file as part of its
          distribution, then any Derivative Works that You distribute must
          include a readable copy of the attribution notices contained
          within such NOTICE file, excluding those notices that do not
          pertain to any part of the Derivative Works, in at least one
          of the following places: within a NOTICE text file distributed
          as part of the Derivative Works; within the Source form or
          documentation, if provided along with the Derivative Works; or,
          within a display generated by the Derivative Works, if and
          wherever such third-party notices normally appear. The contents
          of the NOTICE file are for informational purposes only and
          do not modify the License. You may add Your own attribution
          notices within Derivative Works that You distribute, alongside
          or as an addendum to the NOTICE text from the Work, provided
          that such additional attribution notices cannot be construed
          as modifying the License.

      You may add Your own copyright statement to Your modifications and
      may provide additional or different license terms and conditions
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      for use, reproduction, or distribution of Your modifications, or
      for any such Derivative Works as a whole, provided Your use,
      reproduction, and distribution of the Work otherwise complies with
      the conditions stated in this License.

   5. Submission of Contributions. Unless You explicitly state otherwise,
      any Contribution intentionally submitted for inclusion in the Work
      by You to the Licensor shall be under the terms and conditions of
      this License, without any additional terms or conditions.
      Notwithstanding the above, nothing herein shall supersede or modify
      the terms of any separate license agreement you may have executed
      with Licensor regarding such Contributions.

   6. Trademarks. This License does not grant permission to use the trade
      names, trademarks, service marks, or product names of the Licensor,
      except as required for reasonable and customary use in describing the
      origin of the Work and reproducing the content of the NOTICE file.

   7. Disclaimer of Warranty. Unless required by applicable law or
      agreed to in writing, Licensor provides the Work (and each
      Contributor provides its Contributions) on an "AS IS" BASIS,
      WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or
      implied, including, without limitation, any warranties or conditions
      of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A
      PARTICULAR PURPOSE. You are solely responsible for determining the
      appropriateness of using or redistributing the Work and assume any
      risks associated with Your exercise of permissions under this License.

   8. Limitation of Liability. In no event and under no legal theory,
      whether in tort (including negligence), contract, or otherwise,
      unless required by applicable law (such as deliberate and grossly
      negligent acts) or agreed to in writing, shall any Contributor be
      liable to You for damages, including any direct, indirect, special,
      incidental, or consequential damages of any character arising as a
      result of this License or out of the use or inability to use the
      Work (including but not limited to damages for loss of goodwill,
      work stoppage, computer failure or malfunction, or any and all
      other commercial damages or losses), even if such Contributor
      has been advised of the possibility of such damages.

   9. Accepting Warranty or Additional Liability. While redistributing
      the Work or Derivative Works thereof, You may choose to offer,
      and charge a fee for, acceptance of support, warranty, indemnity,
      or other liability obligations and/or rights consistent with this
      License. However, in accepting such obligations, You may act only
      on Your own behalf and on Your sole responsibility, not on behalf
      of any other Contributor, and only if You agree to indemnify,
      defend, and hold each Contributor harmless for any liability
      incurred by, or claims asserted against, such Contributor by reason
      of your accepting any such warranty or additional liability.

   END OF TERMS AND CONDITIONS
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